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Installing Plugin 
The plugin for Protect My Ministry v3 Integration is available to install through the Rock 
Shop 

 In Admin Tools, select Rock Shop 

 

 On the top of Rock Shop will be orange tabs. Click on "Workflow" 



 

 Scroll through all available Plug-Ins until you see Protect My Ministry 

 *Note* - Protect My Ministry 2.0 is still in the Rock Shop. Make sure you are 
downloading Protect My Ministry 3.0 

 

 If you have not yet gone through the sign up process to get the new integration, there 
will be a link to sign up with Protect My Ministry on the plugin page. Or you can call 
800-319-5581 to talk to a sales associate to sign up. 



 You MUST sign up, even if you are an existing account so PMM can properly 
integrate and update the account 

 

 Install the Protect My Ministry 3.0 Plug-In  

 

Setting up API Key 
Once the account has been signed up by Protect My Ministry, you will receive an email 
confirmation that the account is ready along with an API Key to plug into Rock. 



 When you get the API Key from Protect My Ministry, go into the Admin Tools in Rock 
and select Installed Plug-Ins 

 

 Click on the Protect My Ministry v3 Integration option 

 *Note* If you do not see PMM v3 Integration as an option under Installed 
Plugins, you may need to double check that you have successfully installed 
this plugin 



  

 

 Enter the API Key under Plugin Settings >  Advance Settings  by clicking on the Edit 
button 

 



 

 Updates Notification Group - This is to choose who will receive notifications from 
Protect My Ministry when a new background check package or billing reference is 
added in the PMM Portal.  

Ordering a Background Check 
After installing the PMM 3.0 plugin and entering in the API Key, you will now have the ability 
to order the background checks inside of Rock 

There are two ways to order a background check, through the candidate's Rock profile or 
through the PMM 3.0 plugin 

Through Candidate Profile 

 Inside of Rock, pull up the candidate's profile 

 Under the Actions option, under the candidate's profile picture, click on "Send 
Background Check Invite" 

 *Note* If you have other PMM plugins, you will still see them as an option 
here. For the new integration, the option is only "Send Background Check 
Invite" 



 

 You will be able to choose the type of background check to order and send out an 
online consent form link to the candidate to give consent and other required 
information needed. 

 

 Email - The email address will automatically populate with the candidate's 
email address from their Rock profile. You are able to change the email 
address if needed 

 Package - The diƯerent background check packages that can be ordered 
from your account 



 Billing Reference - Optional. These will only show up on your invoice to 
group together applicants that you've ordered background checks on. These 
will not aƯect the background check 

 Training Type - If you would like this applicant to go through The Child Safety 
Training. The Child Safety Training is a series of videos with a test at the end 
about child abuse awareness. This feature is a yearly cost. If you have not 
signed up with this feature, please contact our Support team at 
support@protectmyministry.com or call 800-319-5581 

 Background Check Email Template – Select the email template to send to 
the applicant with the online consent form link. Created and edited from the 
PMM portal 

 Safety Training Email Template – Select the email template to send to the 
applicant with the Child Safety Training link. Created and edited from the 
PMM portal 
  

 The last step is to look over the FCRA Certification and Submit the order request to 
send the applicant the Online Consent Form 

 *Note* Even though this says Fair Credit Report Act, this does not mean a 
credit report is ordered on your applicant. 

 

 The candidate will receive an email with a link to fill out the online consent form and 
to enter in the required information needed to run the background check and to give 
consent.  



 
Submit With Approval 

Submit with Approval allows an approver in Rock to approve the invitation of the 
background check. 

Note: This feature will only be available with Rock version 16.7 or higher. 

 

 The approver will get the request under My Tasks and approve the background check 
to continue 

 The approver will be able to adjust the background check, billing reference, 
and training type before approving 



 



 When approved, the submission will go through and the email to the online form will 
be sent to the applicant 

 If denied, the submission will go back to the requester with notes from the approver 

 

Order Training through Actions 

In addition to order the Child Safety Training with the background check, you can send out 
the Training by itself 

 Under the Actions menu, there will be a separate Send Child Safety Training Invite 
option 

 

 

 Choose the type of Training to send out: Volunteer, Employee, or Spanish 



 

Through Plugin 

 Go into Admin Tools > Installed Plugins and select Protect My Ministry v3 Integration 

 

 There will be three options, Child Safety Training, Manual Order, and Start Invite 
Order 



 

Child Safety Training – Order the Child Safety Training by itself without a background 
check 

Manual Order – Enter in the applicant’s information yourself if you have the applicant’s 
authorization form 

Start Invite Order – Send a consent form link to the applicant to have them enter in their 
own information online 
 

Child Safety Training 

Send the Child Safety Training link to a single applicant (Single Candidate) or to a Data View 
in Rock (Bulk Invite) 

 
 
 
 



Manual Order 

Order the background check and input the data manually for a single applicant (Single 
Candidate) or to a Data View in Rock (Bulk Invite) 

 

 

Searches – Choose the type of background check and the version of the Child Safety 
Training to order on the applicant 

Information – Enter all of the required information needed to run a background check 

Billing & Email – Choose a Billing Reference and the Child Safety Training Email Template, 
if Child Safety Training was chosen 

Review Order – Review and Submit the order 
 

Start Invite Order 

Send the online consent form link for a single applicant (Single Candidate) or to a Data 
View in Rock (Bulk Invite) 



 

Applicants – Add, Edit, or Delete an applicant from receiving the invitation 

Searches – Choose the type of background check to order after the applicant completes 
the online form 

Billing & Email – Choose a Billing Reference and select the email templates for the 
background check and Child Safety Training, if Training was selected 

Review Order – Review and submit the order 

View Results 
Once the background check is completed through Protect My Ministry, you will receive an 
email notification and you will be able to view it back in your Rock account in two ways, 
through the candidate's profile or through the plugin. 

 *Note* - Both ways will send you to the PMM portal to view the PDF file of the results 

Through Plugin 

 Go back to Admin Tools > Installed Plugins > Protect My Ministry v3 Integration 

 

 Under the Protect My Ministry v3 Integration table will be a Requests table where all 
candidates with a background check request will be listed 



 

 When the report is completed, there will be a PDF file under the Report column to 
the right side of the table. This will take you to the PMM portal to view the completed 
report 

 In the PMM portal, you will click on the "View" hyperlink under the Report column. 
This will bring up the PDF file of the results of the background check 

 

  

Through Candidate Profile 

 Search for the candidate's profile inside of Rock and click on Extended Attributes on 
the top of the profile 

 

 There will be a Safety & Security section and a PMM Background Check History 
section 



 The Safety & Security section will display information from the most recent 
background check ran on the candidate 

 

 The PMM Background Check History section will show all of the background 
check requests ran on this candidate 

 

 To view the results on any of the background checks, you must click on the View in 
Portal hyperlink, which will transport you into the PMM portal. 



 In the PMM portal, you will click on the "View" hyperlink under the Report column. 
This will bring up the PDF file of the results of the background check 

 

Screening Flows 
Screening Flows oƯers a way to have the background check to be placed in the middle of 
an existing workflow. The Screening Flow will need to be created through the PMM Portal, 
then made within Rock's workflows. 

Note: This feature will only be available with Rock version 16.7 or higher. 

 Go into the PMM portal 

 Click on Screening Flows in the left hand menu 

 

 Click on Create New Flow to create a new Screening Flow, or click on the pencil icon 
next to an existing Screening Flow to edit it 



 

  

 

Flow Name - Name of the Screening Flow  

Flow Description - Description of the Screening Flow 

Background Check Package - The background check package that will be ordered 

 



Include Child Safety Training - Toggle to choose if the Child Safety Training will be ordered 
in the Screening Flow 

Include Billing Reference - Toggle to choose if a Billing Reference will be added to the 
order 
  

 To add Screening Flows to your workflows, please view this documentation: 

AddScreeningFlowFunctionalityToYourExistingWorkflow.docx 

Background Check Status 

As soon as the online consent form invitation is sent out or a manual order has been 
submitted, you will be able to view the status of the background check 

 Pending - The background check or Child Safety Training is in progress 

 Invited - The online consent form link has been sent to the candidate, but the form 
is not yet completed 

 Completed - The background check is complete and ready for your review 

 Incomplete - The background check could not be completed due to missing 
information, invalid jurisdiction, no applicant address history. For the Child Safety 
Training, this status means that the candidate has not passed the test  

 Expired - The candidate did not respond to the online consent form link or complete 
the Child Safety Training in the allotted time. The time frame is defaulted to 14 days 

 Rescreen - The applicant has a previously completed background check and is now 
due for another background check. The default time is 1 year but can be adjusted in 
the PMM portal  

 Archived - The candidate has been archived in the PMM portal. This does not mean 
that the background check or candidate is inactive.   

 Success- Child Safety Training status to indicate that the training has been 
completed and the applicant received their certification with a score of 70% or 
higher. 

 



PMM Portal Settings 
Create Background Check Packages 

The default background check packages will be the Essentials, Preferred, and Premiere.  

 Essential - Multistate Criminal Search (National Criminal Search), National 
Sex OƯender Registry, SSN Trace, One County Criminal Search 

 Preferred - Multistate Criminal Search (National Criminal Search), National 
Sex OƯender Registry, SSN Trace, Unlimited Countywide Criminal Search 
(Auto Populated - 7 yrs) 

 Premier - Multistate Criminal Search (National Criminal Search), National 
Sex OƯender Registry, SSN Trace, Unlimited Countywide Criminal Search 
(Auto Populated - 7 yrs), Unlimited Federal by District Search (Auto Populated 
- 7 yrs) 

If any other type of background checks need to be ordered, you may create a new custom 
package inside of the PMM Portal.  

 Inside of the PMM Portal, click on "Packages" in the left side menu 

 



 Click on the blue Custom Package in the upper right or click on the Custom Package 
under "You Custom Packages"  

 

 Name the new package. This can be named whatever, it will be internal for you and 
other users. 

 

 You will be able to choose a Base Package (one of the default background check 
packages) or check the checkbox on the bottom "I do not wish to have a base 
package as part of this custom package" 



 

 Click on "Continue to Add-Ons" to the right side, under Summary 

 



 You will be able to choose individual searches to this custom package from this list 
of Add-Ons 

 

 Click on "Save Package" to the right side 

 

 

 



Create Billing References 

Billing References are labels that will group up candidates on your invoice. You are able to 
attach the Billing Reference to a candidate while ordering the background check.  

 To create a Billing Reference inside of the PMM Portal to add them to the 
background checks, click on the gear icon in the upper right hand corner 

 

 Then select Billing References 

 

 This page will display any Billing References that would have been created. Click on 
the New Code button 

 

 Under the "Title" table, a new field will open for you to type in 

 This can be named anything and this will display on your Invoice 



 

 Click on the save icon to save the Billing Reference. 

 Make sure to add/save each billing reference as you go and refresh each 
time. Otherwise, it causes some issues. 

 The Make Default button will have this Billing Reference automatically appear to be 
attached to the candidate that you order background checks on. 

Edit Email Templates 

When you send out the Online Consent Form invitation to the candidate to have them enter 
in their own information and give consent online, an email will be sent with the link to the 
Online Consent Form.  

 You are able to edit the email message that is sent to the candidate by going into the 
gear icon in the upper right hand corner 

 

 Then select Invite Email 

 

There will be our default email template, which you can edit by clicking on the Edit to the 
right of the Default template.  

 To make a new email template, click on the "+ Email Template" in the upper right or 
the "+ Email Template" under the Default template. 

 Whether you're editing the Default template or creating a new email 
template, you MUST make sure the following tags are entered 



in: [ApplicantFirstName], [ApplicantLastName], [ClientName] and 
[InvitationLink] 

 

 You'll be able to edit the email, the subject line, the name of the template, and the 
body of the email. The only thing you wont be able to edit is the From email address. 

 

 Email Template Name - This will be an internal name to help you locate 
email templates while sending out the Online Consent Form invitation 

 Client Name - As of now, this field does not eƯect anything 



 From - The email address that the email comes from for your candidates 

 Subject Line - The subject of the email 

 Email Message - The body of the email. 

 Please make sure to include the tags [ApplicantFirstName], 
[ApplicantLastName], [ClientName] and [InvitationLink]. These 
tags will auto populate the applicant's first name, the applicant's last 
name, your organization's name, and the specific link to the Online 
Consent Form.  

Add New Users 

You will be able to add new users to be able to order background checks from Planning 
Center. The users will need to go through the Authenticate process to set up the integration 
with their user.  

 To add a new user, go into the gear icon in the upper right hand corner 

 

 Select the "Users & Permissions" tab 

 

 If you are the owner (the person who signed up the account), you will see a Roles & 
Permissions section. Scroll down to view all the users in your account and to be 
able to add a new user by clicking on the + User 

 

 Enter in the new user's information, then choose the permission they will have 



 

Full Admin - User has access to the entire account. View background check results, 
archive background checks, edit billing information, create a custom package, create and 
delete users, edit disclosure and consent, edit invite email template 

Limited Admin - User will only have the ability to send out the online consent form link for 
a background check and send out the Child Safety Training link, if the feature is added onto 
your account. 

  

Edit Rescreen Interval 

Once a background check is ordered, there will be a certain amount of time before a 
background check needs to be reran. Every organization has diƯerent time frames when 
ordering a new background check on a current candidate.  

You will be able to see the candidates that need a new background check in 
the Background Check Dashboard  

 Go into the gear icon in the upper right hand corner 



 

 You will automatically be in the General tab. If not, please select General.  

 

 Scroll down a little, under Notifications, to Applicant Invitation Expiry Interval 

 

 The default interval is 1 year, but can be adjusted to 6 months. 

 If you need a diƯerent timeframe, please contact 
support@protectmyministry.com  

  

 

 



Edit Invitation Expiration 

Through the PMM Portal, there is a way to update how long an Online Consent Form 
invitation link will expire.  

 Go into the gear icon in the upper right hand corner 

 

 You will automatically be in the General tab. If not, please select General.  

 

 Scroll down a little, under Notifications, to Applicant Invitation Expiry Interval 

 

 The default expiration is 14 days (2 weeks), but can be adjusted to 1 week or 1 
month.  



 


